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Project Creation and Gantt Chart Design Using Microsoft Project 
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The University of Tampa 

What is Microsoft Project? 

 Microsoft Project is a software package designed help managers manage a variety of 
different project types from very simple or complex, lasting from hours up to many years.  Utilizing 
MS Project, the project manager is able to program a series of tasks and follow their progress to 
assure that they are accomplished according to schedule. 
 The following sections introduce various concepts regarding project management.  
Included are instructions related to using the software to develop a project, allocating resources, 
tracking its progress, and communicating the project’s results. 
 Users who have experience with project management and only want to improve their 
Microsoft Project skills can skip ahead to the MS Project instructions. 

Chapter Objectives 

 After reading the contents of this chapter, the students should be able to: 
� Describe what are constraints and assumptions and why it is important to define them before 

starting a project; 
� Use Microsoft Project to plan and control projects; 
� Use many of the views available in Microsoft Project to manage projects; 
� Understand the use of a Gantt chart and the importance of Gantt charts in project 

management; 
� Insert tasks, their durations, start and finish into MS Project; 
� Establish relationships between task predecessors and successors; 
� Create a resource pool in MS Project;  
� Assign resources to tasks; 
� Understand and manage project network diagrams. 

Starting a project 

 When starting a project, initially you should define the project’s goals, assumptions, and 
constraints.  The more complex your project is the more important these steps become.  In this 
planning phase it is also important to develop the project scope and any contingency plans for 
dealing with changes to the project's goals. Usually, smaller projects do not need to be as 
thoroughly documented as large ones, but in this planning phase it is still useful to record the 
team’s thoughts about the project. 

 

Determining the project goals 

 Clear goals are essential to any project because the project's success will be determined 
by how effectively these goals are reached. A good project goal is specific, measurable, 
attainable, and relevant to the project and time limited. You should avoid vague goals such as 
"Develop top technology."  Good, clear goals should include:  
� Project deliverables.  
� Specific due dates, both for project completion and intermediate milestones.  
� Measurable quality criterion for the deliverables.  
� Budget costs for the project.  

 
 It is important for all stakeholders to embrace the project goals. Typically, a goal 
statement is developed and used as a guide throughout the project. 
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Defining project assumptions 

 When starting to plan a project, many assumptions are made regarding resource 
availability, how much time tasks will take, how external conditions will affect the project, 
schedules, etc.  These assumptions and estimates are then used to elaborate your project 
schedule.  Keeping track of these assumptions during project execution is important so that you 
can make sure that they are still valid.  Stakeholders should constantly input information that 
allows you to validate your assumptions and update the schedule in case you need to.  Here are 
some factors to consider when evaluating project assumptions:  
� Tasks inherited from other projects or departments: If your work depends on milestones of 

others, do they realize this fact and agree to complete their tasks in the scheduled date?  
� Resource availability:  Are all materials, people, and equipment available?  Who controls the 

resources needed to complete the project? Is the use of these resources approved on the 
scheduled dates by these decision makers?   

� Did you use reliable information to estimate task durations?   
� How rigid is the project budget?  If you need to go over budget, who can approve budget 

increases if necessary?  Is he/she willing to do it? 
� Can tasks be realistically completed in terms of costs and quality within their planned 

durations? 
� Do project deliverables match customer and stakeholders expectations? If deliverables must 

be compromised, have stakeholders agreed? 
 

 To guarantee project success it is very important to identify these key assumptions and to 
develop contingency plans to respond to unexpected events. 

 

Defining project constraints 

 Constraints are factors that limit project choices. There are three main types of 
constraints:  
� Schedule constraints such as a fixed end date or a deadline date for a task or a project.  
� Limitations on the amount of resources available (materials, facilities, equipments, or people).  
� The number or range of tasks to be completed is called the scope.  Scope is the third type of 

project constraint. 
 
 These three restrictions create what is called the "project triangle."  Usually, changing 
one of these constraints will affect the other two, and overall project quality.  When developing a 
project plan, constraints should be listed and analyzed by all the stakeholders to ensure 
commitment and awareness by all involved.  
 Unpredicted constraints will certainly appear during the project.  Equipment may brake 
and costs may increase.  Project stakeholders should agree on how to deal with unexpected 
constraints that arise during the project.  

 
I think you can take everything in yellow bellow out because you are repeating what has just been 
said in the yellow above. (Rodrigo) 

 
Project Constraints 
 Constraints are factors that limit the project manager's options. Typically, the three major 
constraints are: 
1. Schedule, such as a fixed end date or a deadline date for a major milestone. 
2. Resources (material, facilities, equipment, people, and the costs associated with them), such 

as a predefined budget. 
3. Scope, such as a requirement that three models of the product be developed. 

 
 A change in one of the constraints affects the other two, and also affects the overall 
quality. For example, decreasing project time (schedule) may increase the number of workers 
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you'll need (resources) and reduce the number of tasks that can be included in the product 
(scope). The project manager then determines whether this tradeoff is acceptable. This is known 
as the "triple constraints of project management" or the "project triangle." Learn more about the 
project triangle. 

The Project Triangle 

Time Cost

Scope

Time Cost

Scope
 

Figure 1 - The Project Triangle 

 
 Projects are usually limited by their due date, available budget, and scope. These 
constraints are often referred to as the project triangle.  As we mentioned before, adjusting any 
one of these constraints may affect the other two.  While all three elements are important, 
typically one will have the most influence on your project (Microsoft Help, 2002).  For example, if 
you decide to adjust the project plan to bring in the schedule's finish date, you might end up with 
increased costs or a decreased scope or both.  In another situation, you could try to adjust the 
plan to meet the project budget, and may end up having a longer schedule and a decreased 
scope. Or, if you decide to increase scope, your project might take longer and cost more money. 
 Stakeholders should agree on how to respond to unexpected constraints that arise during 
the project. For example, if labor costs turn out to be higher than anticipated, stakeholders may 
be willing to reduce the scope of the project in specific, predefined ways. 
 When working with Microsoft Project, a "constraint" should be considered a restriction or 
limitation set upon a task.  For example, you can specify that a task must start on a particular 
date or finish no later than a particular date. 
 Changes to the triple constraint triangle can affect your project in different ways 
depending on your specific situation and the nature of your project.  In some cases, shortening 
your schedule might increase costs.  In other situations, it might actually decrease them. 
 To establish a Constraint in MS Project, select the View menu, click on Gantt Chart and 
then select the task you want to work with.  Double click the task and in the Task Information 
dialog box click the Advanced tab.  Select a constraint.  If you selected a constraint other than As 
Late As Possible or As Soon As Possible, type a constraint date in the “Constraint date” box. 
 It is also possible to schedule your project from a start date.  This can be accomplished 
by dragging a Gantt bar to change the start date or typing a start date for a task.  Microsoft 
Project sets a Start No Earlier Than (SNET) constraint based on the new start date. If you type a 
finish date for a task, Microsoft Project automatically sets a finish no earlier than (FNET) 
constraint. 

Prepare a scope management plan 

 Once the project's assumptions, and constraints are identified, stakeholders should start 
to elaborate a scope management plan. This plan should include the project goals, the tasks 
required to accomplish these goals, and the work required to complete the tasks.  It should also 
include contingency plans and some thoughts about how change control will be made possible.  
Contingency plans are procedures for implementing changes into the project.  It addresses issues 
such as who should be notified in the event changes are needed, who ought to approve 
acquisition of additional resources or change task priorities.  Some issues that should be included 
in your scope management plan would be:  

� An evaluation of potential threats to the scope of the project and how likely, how often, 
and by how much the scope may change.  
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� What actions should be taken to identify changes and how they should be classified. 
� An action plan containing people that should be notified, documents that should be 

generate and other necessary steps that should be taken once a scope change is 
identified. 

� A carefully designed scope management plan can be used as the starting point for a 
project contingency plan.  

Starting a new MS Project file 

 When you create a new project file on MS Project, the Project Information Dialog box 
automatically appears.  It can be used to enter, review, or change initial information for a new 
project.  You can also gain access to this dialog box by clicking on the Project menu, and 
selecting Project Information.  Using the project information dialog box you can: 
� Select if the project should be scheduled from the start date or the finish date.  If you select 

start date the program will calculate the beginning date of each task by adding from the first 
task.  If you select finish date MS Project will calculate the beginning date of each task by 
subtracting from the project due date.  You should note that if you choose to schedule from 
the start date, the finish date box becomes unavailable. 

� Enter the date you want MS Project to consider the Current date. 
� Set the Status date.  This is the date used to calculate earned value and to create progress 

lines. 
� Specify the type of base calendar that should be used as the project calendar. 
� Use the Priority setting to indicate how readily tasks in the current project are delayed when 

resources are leveled across multiple projects (MS Project Help 2002).  A higher number 
indicates a higher priority.  

� Obtain overall project statistics such as start and finish dates, duration, work, and cost. 
 
 The calendar drop down specifies the base calendar used to calculate working times for 
the project.  The options are: 
� Standard Work Day.   A standard work day of 8:00 A.M. to 5:00 P.M., with 12:00 P.M. to 1:00 

P.M. of nonworking time for a break, and work week of Monday through Friday. 
� 24 Hours (work time, example – three shifts).  This calendar has no nonworking time.  Work 

time is 24 / 7 (24 hours per day, 7 days a week). 
� Night Shift.   This is used for night periods. Working times are Monday night through Saturday 

morning, 11:00 P.M. to 8:00 A.M., with 3:00 A.M. to 4:00 A.M. of nonworking time for a break. 
 
 You can click Properties on the File menu to enter or review additional project-level 
information.  In Project, you set constraints by specifying that a task must start on a particular 
date or finish no later than a particular date. New tasks scheduled from the start date have a 
default constraint of As Soon As Possible (ASAP). Tasks scheduled from the finish date have a 
default constraint of As Late As Possible (ALAP).   

Gantt Chart View 

 The default view in MS Project is the Gantt Chart view.  In it, users can see task 
information as both text and bar graphics because the window is split into two sections.  On the 
left side columns (containing Microsoft Project fields) are shown.  You can use these columns to 
modify task names, durations, start and finish dates, and other information.  Other fields may 
include Task Number, Indicators, Predecessors, Resource Names, planned and actual costs.  
The right side of this view shows the Gantt chart.  This chart is made up of bars that graphically 
display task durations and start and finish dates on a timescale.  This sequence of bars shows 
the order in which tasks are scheduled to occur.  Gantt Chart view is useful when:  
� Entering tasks and task durations. 
� Establishing sequential relationships between your tasks. This view allows you to see how 

changing task duration affects the start and finish dates of other tasks and the project finish 
date. 

� Designating resources to a task. 
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� You want to watch how much of each task is complete and follow the progress of your project 
by comparing actual start and finish dates with the planned dates. 

 
 Gantt Chart views can be customized to meet your needs.  Your changes to 
the view are saved with the project file.  Some things you can change in the Gantt 
Chart view, are:  
� The number of columns and the information that is displayed.  For example, you 

can display, hide, or change the appearance of nonworking time. 
� The formatting of fonts. For example, you can apply bold to an important finish 

date or increase the size of column titles. 
� How units of time are shown. 
� The formatting of the Gantt bars.  You can use this option to emphasize specific 

conditions in the schedule.  For example, you could change the color of a critical 
task. 

� How gridlines are displayed. You can use this option to enhance the readability 
or clarity of the Gantt Chart. For example, you can specify different line patterns 
and colors for column, row, and title gridlines. 

� Draw your own labels or figures to the Gantt Chart. 
� Whether or not subtasks are displayed.  

 

 

Figure 2 - View Bar Gantt Chart Icon 

 

Hands on Exercise: Create a project for the Minaret Technologies Database 

 
1. Open Project.  If the Task Panel appears, click the X 
 at the top-right corner to close the panel. 
 
2. Select Project on the menu bar and then click 

“Project Information…” (Figure 4). 

Figure 3 - Task Panel 

 
 

 

Figure 4 - Project Information Dialog Box 

 
3. Set the project start date to the first day of the term.  Accept all other default values by 

clicking OK. 
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4. Make sure the View Bar is displayed, by clicking View on the Menu Bar then View Bar.  
The View Bar displays on the left side of the screen.  Click the Gantt Chart button on the 
View Bar.  You should have something that looks like the following figure: 

 

 

Figure 5 - Project window for a new project in Gantt Chart view 

 
5. On Task Name column type the first task from the Minaret Technologies Task List – 

System Investigation. 
 
6. Now, click into the second row of the Task Name column and enter the second task from 

the Minaret Technologies Task List – Define Problem. 
 
7. To enter the duration of this task press the tab key or the right-arrow key.  Enter two-hour 

(2h) duration for the task.  Task durations are input in units of minutes (m), hours (h), 
weeks (w), or months (mo): 1m, 1h, 1w, 1mo.  You can also use the arrows to change 
number of days. 

8. In project, you can create what are called summary tasks.  It summarizes the idea of a 
group of subtasks.  They also help by making long projects easier to display.  To create a 
summary task for a group of subordinate tasks, click on the task number of the first of the  

 

Figure 6 - Toolbar Demote button 

 subordinate tasks and then click the Demote button  on the toolbar.  Use this 
procedure to make the Define Problem a subordinate task component of System 

Investigation.  Notice how the task bar for System Investigation changes shape  and 
the text becomes bold.  This is how summary task bars are displayed. 
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9. If you Drag the divider bar to the right, you can reveal other fields such as Start Date, 
Finish Date, Predecessors, and Resources.  Start and finish dates are set by project 
based on start/finish choice in Project Information Dialogue Box and task duration. 

 
10. Drag the divider bar to the left to hide the Start Date.  Notice how Project displays Gantt 

Chart timeline bar for the task. 
 
11. Enter the third task from the Minaret Technologies Task List – Feasibility Study on the 

third row.  Enter a two-hour duration for the task.  Demote the task to make it a 
subordinate component of System Investigation.  Notice how the duration for System 
Investigation becomes the sum of the subordinate tasks. 

 
12. Enter the fourth task from the task list – Project Management Plan and demote the task 

to make it subordinate. 
 
13. Enter the fifth task from the task list – Gantt Chart – Design Project.  Enter the duration 

indicated on the task list.  Click the demote button twice to make the task a subordinate 
to the Project Management Plan task as indicated. 

 
14. Enter the sixth task from the task list – Resource Sheet – Assign Resources.  Enter the 

duration and demote as indicated. 
 
15. Enter other tasks in project from the Project Task List.   
 
 If you forget or skip a task you can enter it at the last row and then reorder the task.  You 
reorder a task by clicking on the Task Number and then dragging the task up or down to place it 
in the correct row. 

Minaret Technologies Task List 

 
System Investigation  

 Define Problem 2h 

 Feasibility Study 2h 
 Project Management Plan  
 CHAPTER 1  1w 
 CHAPTER 2 1w 

System Analysis  

 End User Needs Analysis 5d 

 Current System Analysis 5d 

 Define System Requirements 5d 
Database Design  
 CHAPTER 3 1w 
 CHAPTER 4 1w 
 CHAPTER 5 1w 
 CHAPTER 6 1w 
 CHAPTER 7 1w 
 CHAPTER 8 1w 
 CHAPTER 9 1w 
 CHAPTER 10 1w 

System Implementation  
 CHAPTER 11 1w 
 CHAPTER 12 1w 
 CHAPTER 13 1w 
 CHAPTER 14 1w 
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System Maintenance  

 PowerPoint Project Overview 2d 

 Project Completion and Review 1d 

 
 

 

Figure 7 - Recurring Task Information input box 

Recurring Tasks 

 Projects usually have tasks that repeat themselves throughout the duration of the project.  
Such tasks, like meetings or inspections, usually involve the same individuals (resources).  Let’s 
look at an example by scheduling a “Recurring Task” named MTI Database Committee Meeting 
using the following steps: 
 
16. Click on the task name on the task list.  Click Insert then click Recurring Task.  The 

Recurring Task Information input box opens. 
 
17. Type in the task name MTI Database Committee Meeting.  Select the weekly recurrence 

pattern every week on Monday.  Start the Range of Recurrence to the project inception 
date.  Select the standard calendar and click OK. 

 
18. Move the meeting recurring task to the first row of the task list. 
 
19. On the Gantt Chart view you can use the +/- sign toggle to show each meeting 

individually or group all the meetings in one item. 
 
20. When executing real projects, some tasks must be completely done before the next one 

begins.  The task that MUST be completed before its successor starts is called the 
Predecessor.  Setting a Predecessor makes the successor task dependent on the 
Predecessor.  You can set Predecessor tasks in MS Project, by clicking in the task then 
click Project in the menu bar and select Task Information (or double click on the task in 
the Predecessor field of the Gantt chart).  See Task Dependencies for additional 
information regarding dependencies.   
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Task Dependencies 

 In real life, projects are composed of a sequence of tasks.  These task have relationships 
between them regarding whether or not a task can start before its predecessor is finished.  These 
relationships are called task dependencies.  A task that depends on another is the successor, 
and the task it depends on is the predecessor. Establishing dependencies in Microsoft Project 
allows you to calculate the successor's start date and finish date based on the predecessor's start 
date or finish date, the dependency type, and the successor's duration. Four types of task 
dependencies can be used to link predecessors and successors.  The nature of the relationship 
between the predecessor and successor determines the task dependency type to be used.  MS 
Project Help does a good job in defining the four kinds of relationships that can be established.  
They are: 
 
 Finish-to-start (FS)   

Task (B) cannot start until task (A) finishes. For example, if you have two tasks 
"Construct wall" and "Paint wall," "Paint wall" can't start until "Construct wall" finishes.  
This is the most common type of dependency. 

 
Start-to-start (SS)   
Task (B) cannot start until task (A) starts. you have two tasks "Pour foundation" and 
"Level concrete," "Level concrete" can't begin until "Pour foundation" begins. 
 
Finish-to-finish (FF)   
Task (B) cannot finish until task (A) finishes. For example, if you have two tasks, "Add 
wiring" and "Inspect electrical," "Inspect electrical" can't finish until "Add wiring" finishes. 
 
Start-to-finish (SF)   
Task (B) cannot finish until task (A) starts. This  dependency type can be used for just-
in-time scheduling up to a milestone or the project finish date to minimize the risk of a 
task finishing late if its dependent tasks slip.  

 
 If a related task needs to finish before the milestone or project finish date, but it doesn't 
matter exactly when and you don't want a late finish to affect the just-in-time task, you can create 
an SF dependency between the task you want scheduled just in time (the predecessor) and its 
related task (the successor). Then if you update progress on the successor task, it won't affect 
the scheduled dates of the predecessor task. 

Lead / Lag Time 

 What happens if you want to enter a task in MS Project that can begin when its 
predecessor is 60% complete?  The program allows you to enter overlapping tasks by defining a 
Lead time for the successor task.  In our example, if a task can start when its predecessor is 60% 
finished, you can specify a finish-to-start relationship with a lead time of 60% for the successor. 
You enter a lead time as a negative lag value.  
 Lag time is the opposite of lead time.  It is a delay between tasks that have a 
dependency. For example, if you want to start the successor two days after the predecessor is 
finished, you can define a finish-to-start relationship and specify two days of lag time.  Lag times 
are entered as a positive value.  
 You can enter lead time or lag time as a duration or as a percentage of the predecessor 
task duration. Type lead time as a negative number or as a negative percentage, and type lag 
time as a positive number or as a positive percentage.  
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Figure 8 - Task Information Window 

 
21. To set task predecessors and Lead/Lag times click on the Predecessors tab in the Task 

Information window (you can access this window by performing the steps in item 20).   
Select a task from the drop down in the “Task Name” column.  Select the relationship 
type from the “Type” column.  Set Lag (remember that Lead time is a negative lag time) 
time.  Click OK 

 
22. Using the above procedure set the following Predecessors.  Use the default Type and 

Lag settings: 
 

Task Predecessor 

Database Design Project Management Plan 

Chapter 2 Chapter 1 

Chapter 4 -  Chapter 3 -  

Chapter 5 -  Chapter 4 -  

Chapter 6 -  Chapter 5 -  

Chapter 7 -  Chapter 6 -  

Chapter 8 -  Chapter 7 -  

Chapter 9 -  Chapter 8 -  

System Implementation Database Design 

Chapter 11 -  Chapter 10 -  

Chapter 12 -  Chapter 11 - 

Chapter 13 -  Chapter 12 -  

Chapter 14 -  Chapter 13 -  

System Maintenance System Implementation 

Project Completion and Review PowerPoint Project Overview 

 
23. When you set task dependencies, arrows appear in the Gantt Chart to indicate that the 

tasks are linked. 
 
24. An alternative method of linking tasks is to select both tasks and click the link button on 

toolbar.  To unlink tasks, select the tasks and click the unlink button on toolbar. 
 
25. As an example, set the tasks “End User Needs Analysis” and “Current Systems Analysis” 

as predecessors to the “Define Systems Requirements” task.  Set a lag time of 5 days 
between “Define Systems Requirements” and the other two tasks. 
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Critical Path 

 The critical path is the series of tasks that will postpone the project’s finish date if they are 
delayed. That is, when the last task in the critical path is completed, the project is completed.  
You should pay close attention to the resources and due dates of critical tasks because they 
determine whether your project will finish on time. 
 The critical path can be found by determining the longest path in your Gant Chart or 
network diagram.  The critical path can change during the execution of you project as some tasks 
are delayed more then others.  There is always one overall critical path for any project schedule. 
As the critical path changes you need to shift you attention to the new tasks in it to ensure the 
scheduled finish date.  Follow the procedure described in item 26 bellow to view the critical path 
in the Detail Gantt Chart. 
 Slack is the amount of time a task can be delayed without affecting the start date of 
another task or the project’s finish date.  Free slack is the amount of time a task can slip before it 
delays another task.  Total slack is the amount of time a task can slip before it delays the project’s 
finish date.  When the total slack is negative, the task duration is too long for its successor to 
begin on the date required by a constraint.  Slack is displayed on the Detail Gantt as a thin line to 
the right of a task not on the critical path 
 
26. You can display the critical path by clicking on the View menu, select More Views then 

click Detail Gantt, and then click Apply.  Alternatively, you can select Critical from the 
Filter drop-down box on the Gantt Chart toolbar to display only critical tasks.  

 
27. Save your project to disk.  Click File then click Save or click the save button on the 

toolbar.  Name the project and click save.  The Planning Wizard window opens.  Make 
sure “Save ‘Your Project’ without a baseline” is checked and click OK.   The baseline is 
the set of original project estimates. This set consists of the original tasks, resource 
assignments, and cost estimates that were originally entered into the project plan 
(Microsoft Help, 2002). 

 
28. To make visualization easier you can add the Zoom button to your toolbar. Click View on 

the Menu bar.  Then click Toolbars and select Customize. In the Customize window 
select the Commands Tab and click View in the Categories scroll box. Click on Zoom… 
drag it to the toolbar to the right of the Filter drop down and release. 

 

 

Figure 9 - Customize Toolbar Window 

29. You can use the zoom button to view the Gantt chart for the entire project.  To achieve 
this result click on the Zoom button, select the “Entire Project” option and click OK.  
Project will reduce the whole Gantt view to fit into the available space. 
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30. Click the Undo button on the toolbar to return to the previous view.  Sometimes you 

“loose” the position of you project in the Gantt Chart.  To reposition the Gantt Chart to a 
selected task you can click the “Go To Selected Task” icon on the toolbar.  The Gantt 
Chart bar of the selected task will then be displayed in the window.  

 

 

Figure 10 - Go To icon on the Toolbar 

 
31. To change the properties of a task, you can use the Task Information icon on the toolbar. 
 

 

Figure 11 - Task Information icon on the Toolbar 

 
32.  The Task Information button opens the Project Task Information Dialog Box.  Click the 

various tabs to view the available choices. 
 

33. You can use the Task Information Dialog Box to create a constraint for a task.  Click on 
the Advanced tab, click the down arrow beside Constraint type, select the desired 
constraint and set the Constraint date.  Click OK.  

  
34. Click the +/- toggle in front of the summary task name.  This allows the subordinate tasks 

to be viewed or hidden. 
 

 
Figure 12 - Setting constraints in the Task Information window 

 
36. Save and back up all work to your zip disk or CDRW.  ALWAYS BACK UP your work to 

a second disk or to your hard drive.  If you loose your disk and do not have a back up, 
you will be required to start over from the beginning. 

The following figure shows what your Gantt Chart should look like:  



 1-13  

 

Figure 13 - Completed Gantt Chart without resources assigned 

 
 To print the project in landscape, select File on the Menu Bar, then click Page Setup.  
Then click the Landscape button. 
 

 

Figure 14 - Page Setup box 
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Study Questions: Chapter 1 
 
1. What are project constraints? 

 
 
 
 
 

2. What are the three major constraints that affect a project? 
 
 
 
 
 

3. List the most important views used to develop and manage projects. 
 
 
 
 
 

4. What are Gantt charts?  Why are they important? 
 
 
 
 
 

5. Briefly describe how to create tasks in MS Project. 
 
 
 
 
 

6. What is a summary task? 
 
 
 
 

7. What are task dependencies? 
 
 
 
 
 

8. Briefly describe how to create task predecessors. 
 
 
 
 

9. What are lead time and lag time? 
 
 
 
 
 

10. What is a Critical Path? 
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Deliverables for Chapter 1: 

 
Print and turn in the following deliverables IN THE ORDER LISTED BELOW. 
 
1. The Gantt Chart View of your project displaying the Task Name and Duration in the left 

window and the Gantt Chart zoomed in to display the entire project in the right window. 
 
2. The Gantt Chart View of your project displaying the Task Name, Duration, Start date, 

Finish date, Predecessors and Resource Names columns.   
 
3. The Network Diagram View of your project.  Hint, click the Network Diagram icon on the 

View Bar. 
  
4. Study question answers for the chapter typed in Microsoft Word. 
 
Type a cover sheet using MS Word with the following information: 
 

Your Name 
Date 

ITM 335 
Chapter 1 

 
Staple the cover sheet to the front of the deliverables.  All Chapter 1 assignments must be turned 
in together.  Partial assignments are not accepted. 


